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About This Course 

This course is designed to offer a hands-on experience with the Report Designer that is 

included with all BS&A applications. It is not an exhaustive demonstration of the software. 

This course manual is intended to be a companion to the Tax software manual, the 

electronic version of which may be used during class time. 

This book is yours to keep. Space has intentionally been made 

available throughout for you to record your own notes. 

  

Contact Us 

Help Menu 

Either option puts your request directly into 

our contact management database. Help 

requests submitted in either of these 

manners get the same first-come, first-

served attention as a traditional phone call. 

  

Option 1: Go to Help>Contact Customer 

Support>Request Support Phone Call 

Option 2: Go to Help>Contact Customer 

Support>Email Support 

Phone Toll free at (855) 272-7638 

Email taxsupport@bsasoftware.com 

I.T. SUPPORT EMAIL itsupport@bsasoftware.com 

Web http://www.bsasoftware.com/Contact 

Fax (517) 641-8960 

  

  

mailto:taxsupport@bsasoftware.com
mailto:itsupport@bsasoftware.com
http://www.bsasoftware.com/Contact
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The Basics 
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Getting Started 

It is important to select the proper report Category on which to base your user report. For 

example, if your report will be comprised primarily of special assessment data, be sure to 

select Special Assessment Reports from the Reports menu. 
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If you happen to have selected a different Category from the Reports menu, you may 

switch categories in the Run Reports screen. 
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Most report Categories give you the option of either basing your report on a system report, 

or adding a blank report. The System Report option includes fields that may be added to, 

removed, or otherwise manipulated; the Blank option does not - you have a clean slate 

from which to begin. This course will take you through adding a blank report. 
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The "Audit Reports" Category only allows you to base your report on a system report. 

 

The "Tax Journal" and "Custom Reports for Various Jurisdictions" Categories do not allow 

user report creation. 
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Add the Report 

  

1. Select the Parcel Reports Category and click the Add Report button. 
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2. Select Add Blank Report. 

 

Include Page Header defaults to on; Include Report Footer defaults to off; Master 

Report Table defaults to ParcelMaster (in this example). We will accept these defaults. 

Adding a footer will be covered separately. Utilizing Child Tables will be a class 

discussion, time permitting. 
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3. Click OK, then click Yes when prompted to continue. You are prompted to enter a 

name. 

 

4. Click Ok. The Report Designer opens. 
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Edit the Report 

Designing a report can be an elaborate undertaking. You may need to exit the designer 

from time to time. You can easily return to edit mode by clicking the Edit button in the Run 

Reports dialog. 
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Report Designer Layout 

 

  

1 - Title Bar 

The Title Bar includes the name of your user report. 

  

2 - Menu Bar 

File, Edit, Format, and View contain numerous options to aid in report design. 

  

3 - Tool Bar 

In addition to typical formatting buttons, the following tool buttons are available: 

Show/Hide Toolbox, Field List, and Property Grid: This button acts as a toggle to 

show or hide a pane that provides tools, fields, and property settings. This will be 

covered in detail later. 

Manage Dialog Fields: A dialog field prompts users for input. Dialog fields will be 

covered in detail later. 

Zoom In; Zoom Out: These buttons are used to zoom in and out of the design field.  
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4 - Sections 

Available sections and their titles vary by report Category. Sections can be quite complex; 

the following is a rough sketch of their use in report design. Each section has a specific 

location in the report body. 

 

Top Margin: Fields placed here appear in the top margin of every page generated. 

Report Header: Fields placed here appear at the beginning of the report. 

Page Header: Fields placed here appear at the top of every page generated. 

Group Header: This is used in reports for which separate totals are wanted. Fields 

placed here appear once at the top of the data group. 

Detail: Fields placed in this section appear once for each record found. 

Group Footer: This is used in reports for which separate totals are wanted. Fields 

placed here appear once at the bottom of the data group. 

Report Footer: Fields placed here appear at the end of the report. 

Page Footer: Fields placed here appear at the bottom of every page generated. 

Bottom Margin: Field placed here appear in the bottom margin of every page 

generated. 
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Toolbox; Field List; Property Grid 

When the Report Designer opens, this pane is hidden; the button uses the term, "Show."  
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It is recommended that you click this button upon accessing the report designer. The 

button will change to "Hide." 
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Field List 

This tab contains the fields that you can place in the different report sections. It is divided 

into three groups of fields: Report Fields are fields drawn from the program, subject to the 

type of report you are designing. Report Field Favorites contains fields you marked as 

favorites. Dialog Fields contains dialog fields you set up for the current report. 

Report Fields is further divided into fields specific to the Category in which you added the 

user report, and "SystemInformation" fields. System Information is data that spans 

Categories, including the database name, system date, and - in the case of Tax - the current 

season. When you highlight a field in the Field List, a snapshot of information is provided in 

the Selected Field Information box. 
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Toolbox 

This tab offers tools to aid you in the design of your report (text labels, lines, pictures, etc.). 

 

  



Tax. NET: Report Designer 

[ 18 ] 

Property Grid 

This tab lets you set the properties of the currently-selected field or section, such as font 

and size, text alignment, etc. 
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Set the Report Page Layout (Portrait or Landscape) 

For the purpose of this course, we will use the default Portrait page layout. To change the 

page layout to Landscape, go to Format>Report Page Layout. 
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Add a Section 

When we added the report, we did not include the Report Footer. 

  

1. Right-click in any section.  
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2. Select Insert Section, then Report Footer. 
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The section is added in its "natural" location. 
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Resize a Section 

In our example, the ParcelMaster_Section is the Detail section. Fields placed in this section 

will repeat for every record found. To keep the report from containing too much "white 

space" between records, we need to shrink this section. 

  

1. Position your cursor on the border between the ParcelMaster_Section (Detail) and 

ParcelMaster_Section_Report Footer. 
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2. Press and hold down your left mouse button and drag your mouse up. 
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3. Release your mouse button. 
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If you wish to increase or decrease the depth of the header and/or the footer section 

(pictured), place your cursor at the bottom of that section and repeat, moving up or 

down. 
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Add Fields 

This lesson will add a label field and a data field, in two different sections. The label field 

"describes" the data that will appear in the data field. 

  

Label Field 

  

1. Click the Toolbox tab. 
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2. Position your cursor on top of Text Label, press and hold down the left mouse 

button, and drag your cursor to the bottom left of the Page Header. 
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3. Release your mouse button. The label is placed, and defaults to Text Label. 
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4. While the field is "selected" (surrounded by a border and handles), type Parcel 

Number. Do not press Enter. 
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5. Click an area outside of the selection box to "place" the label field. 

 

Your screen may resemble the screen shot above, where we can't see the entire 

word, "Number." Resizing a field will be covered shortly. 
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Data Field 

  

1. Click the Field List tab. 

 

2. We want to add the data field that will bring in the parcel number. We can expand 

the ParcelMaster list beneath Report Fields and scroll until we find it, or we can 

search for it. 
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Position your cursor in the Search box and type parceln. As each character is typed, 

the intelligent search features kicks in and tries to find matching fields. 

 



Tax. NET: Report Designer 

[ 34 ] 

3. Position your cursor on top of ParcelNumber_MASTER, press and hold down the left 

mouse button, and drag your cursor to the Detail section, below the location of the 

label field from the last exercise. 
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4. Release your mouse button and click an area outside the selection box to place the 

data field. 

 

Your screen may resemble the screen shot above, where the alignment of the label 

field and the data field is off. Aligning fields will be covered shortly. 
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Resize a Field (Stretch; Shrink) 

The Parcel Number label field from our last lesson is too small to accommodate the 

visibility of all letters. 

  

1. Click on top of the Parcel Number label field. Notice the handles that surround it. 

 

2. Position your cursor over the handle that appears along the right side of the selection 

box. 
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3. Press and hold the left mouse button and drag your cursor to the right. 

 

4. Release the mouse button. 

 

5. Repeat for the data field. 
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Add an Object (Line; Shape; Picture; etc.) 

This lesson adds a line to the Page Header, to make the label fields that get placed there 

"pop" as headings. 

  

1. Click the Toolbox tab. 
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2. Position your cursor on top of Line, press and hold down the left mouse button, and 

drag your cursor to a location beneath the Parcel Number label field in the Page 

Header. 
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3. Release your mouse button. The line is placed. 

 

We can increase the length of the line by way of the handle, like we did for the label 

and data fields, or we can use the Property Grid tab. This will be covered shortly. 
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Align Fields 

We now have three fields (two fields and one object; but for these purposes, we'll just use 

the term "fields") on our report, none of which are aligned along the same axis.  

  

1. You should still be on the Toolbox tab. Click on Pointer. 
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2. Position your cursor above the Parcel Number label field, press and hold down the 

left mouse button, and drag your mouse down through all three fields. 
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3. Release your mouse button. All three fields are selected. 
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4. Go to Format>Align and select Lefts. 
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The fields are aligned. 
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Move Fields 

This lesson takes the three fields from the previous lesson and moves them to the left. 

  

1. You should still be on the Toolbox tab, and Pointer should still be the active tool. 
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2. Repeat the selection method shown in the previous lesson. 

 



Tax. NET: Report Designer 

[ 48 ] 

3. You can either press and hold your left mouse button on any of the fields and 

click/drag, or use your keyboard's arrow keys. Regardless of your chosen method, 

move the fields to the left. 
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4. Click outside any of them to remove the selection. Move the line object a little further 

left, using whichever method you're comfortable with. 
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Summarize Fields 

Numeric fields can be summarized in the footer of a report. In this lesson, we will add two 

additional data fields (and their accompanying label fields) that will be summarized in the 

Report Footer. 

  

1. Click the Toolbox tab and add a Text Label called Sum Billed Amt. If necessary, stretch 

the field to accommodate the letters. 
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2. Add another label field for Win Billed Amt. You can either repeat the action from step 

1, or copy/paste the label from step 1 (used in this example). 
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Click the caret in the upper right of the label field and change Sum to Win (field 

properties will be covered in more detail later in the class).  
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3. Add the data fields to pull in the summer and winter billed amounts. 
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4. Copy/paste both of them into the Report Footer. 
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5. Click the SumTaxesBilled data field to select it, then click the caret to open its 

properties. 

 

6. Click the ellipsis at the right edge of the Summary setting. 
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7. Click the dropdown at the right edge of the Summary Function setting. 

 

[class discussion of the options] 
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Add Date and Page Numbering 

To include the date on which the report is generated, we will add a SystemInformation field 

from the Field List. Page numbering is added from the Toolbox. 

  

1. Click the Field List tab and expand the Report Fields category. 
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2. Expand the SystemInformation category, then click/drag SystemDate to the upper left 

corner of the Page Header. 
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Release the mouse button to place the field. 
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3. Click the Toolbox tab, then click/drag PageInfo to the upper right corner of the Page 

Header. 
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Release the mouse button to place the field. 

 

Notice how it defaults to 1/1. This means that when the report is generated, you will 

see [page number] / [number of pages]. 
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If you would rather see just the page number, click the caret, click the dropdown next 

to Page Info, and select Number. 

 

The printed result: 
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Properties (Appearance) and Field Tasks 

So far, field properties have been touched upon, but not explored in detail. This lesson will 

primarily consist of class discussion. 

  

Each field on the report has its own "tasks" menu that is accessed by clicking on the caret 

that is provided in the upper right corner when the field is selected. 
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The tasks menu is an abridged form of the properties available in the Property Grid. 

Pictured is an example using a data field. Label (Text) fields, System fields, and Objects all 

behave in a similar fashion. 
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In an earlier lesson, we showed you how to resize fields by using handles. Resizing can also 

be done in the Property Grid. In this example, we've selected the line object. Its length 

defaults to 100 pixels. 

 

We've changed 100 to 600. 
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The Property Grid tab reflects the element currently selected. This will be a data or label 

field, an object (line, box, etc.), or the section itself. Pictured is an example where the 

Report Footer section is the active selection. 
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Dialog Fields 
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Set Up the Dialog Field 

A dialog field prompts users for input. 

  

1. Go to Edit>Manage Dialog Fields. 
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2. Click Add and enter a name - no spaces - for the dialog field. 
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3. Click Ok. You may now set the properties of the dialog field. 

 

For our example, we will accept the default Get Text Value. When we receive the 

prompt, we will be able to enter the due date as (using Summer as an example) 

9/15/xx, or Sept 15, xx, or September 15, xxxx; our only restriction will be the Max 

Text Length we can enter here. Examples of Numeric, Date, and Yes/No Values are 

given below. 
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4. Add a dialog field for the winter date, and call it WinterDueDate. 
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The order in which the dialog fields appear is the order in which the user will be 

prompted. In this example, the user will be prompted to enter the Summer due date, 

then the Winter due date. You control the order in which users get prompted by 

using the Move Up and Move Down buttons. 

 

5. Click Ok. 
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Dialog Prompt Examples 

Once the dialog fields have been created, they will be available to add to the report (next 

lesson). Upon running the report (two lessons from now), users will be prompted for data 

entry according to the type of dialog fields that have been added. Our example above uses 

Text; pictured are what the prompts will look like for Numeric, Date, and Yes/No dialog 

fields. 
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Add the Dialog Field to Your Report 

  

1. Click the Field List tab and expand the Dialog Fields category. You will see the two 

dialog fields we created in the last lesson. 
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2. Click/drag the SummerDueDate field to the Page Header, just above the Sum Billed 

Amt label field. 
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3. Repeat for the WinterDueDate field. 

 

4. Save and exit the report. 
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Test the Dialog Field 

  

1. Make sure the Name field is displaying your user report and that the Destination is 

set to Screen, and click Run Report. 
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2. You will receive a Report Options dialog. Leave the Include Inactive Parcels setting 

unchecked and click Close. 
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3. You are prompted to enter the SummerDueDate. 
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4. Because we set this up for text entry, you may enter the date in any format you wish. 

Do so and click Next. 

 

The button is labeled Next to indicate that more prompts are coming. 
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5. You are prompted to enter the WinterDueDate. Do so and click Ok. The button is 

labeled Ok to indicate that this is the final (if not the only) prompt. 

The report processes and appears onscreen. For illustrative purposes, we have 

entered the due dates differently. 

 

6. Close the report to return to the Run Reports dialog, then click the Edit button to 

return to the Report Designer. 
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Calculated Fields and If Statements 
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Create a Calculated Field 

Calculated fields are custom fields that use mathematical expressions to achieve a specific 

output. In this lesson, we will add a calculated field to the Detail section that adds the 

Summer Billed Amount and the Winter Billed Amount. Time-permitting, more complicated 

examples may be addressed as part of class discussion. 

  

1. If you haven't already, click the Show Toolbox, Field List, and Property Grid button. 

2. Click the Toolbox tab, then click/drag Calculated Field to the right of the 

WinTaxesBilled data field in the Detail section. 
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3. When you release your mouse button, your screen should resemble the following 

picture. 
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4. Type TotalBilledAmt in the Expression Name field, then click the UseExpression radio 

button. 

 

5. The formula we're going to use, if written out longhand, would read as follows: 

(SumTaxesBilled(taxbill_nointrst_0) + 

WinTaxesBilled(taxbill_nointrst_1)) 

It is important that the field name be exact, so it is oftentimes easier to use the 

buttons to the right of the expression entry box and select the field name, rather 

than attempt to type it out. 
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6. Click the open parenthesis button. It is placed at the top of the entry box. 
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7. Click the Insert Value button, then click the Data Column radio button. 
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8. Open the ParcelMaster category and locate SumTaxesBilled(taxbill_nointrst_0). 

 

9. Click Ok to return to the Add Value dialog. 
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10. Click Ok to return to the Calculated Expression Editor dialog. 
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11. Click the plus sign button. Click the Insert Value button, then click the Data Column 

Radio button. The Data Column Selector has retained the set of fields you searched 

through when trying to locate the summer billed field. Locate 

WinTaxesBilled(taxbill_nointrst_1). 
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12. Click Ok to return to the Add Value dialog, then click Ok again to return to the 

Calculated Expression Editor dialog. Click the close parenthesis button. Your screen 

should resemble the following picture. 
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13. Click Ok to return to the Report Designer. The calculated field is saved. 

 

14. Save and exit the report. Run the report to see the results.  

15. Close the report to return to the Run Reports dialog, then click the Edit button to 

return to the Report Designer. Delete the calculated field. We're going to replace it 

with an If-Statement in the next lesson. 
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Create an If-Statement 

If-Statements are calculated fields that use conditional, if-true-then-[this]; if-false-then-

[that] expressions. In this lesson, we will add an If-Statement to the Detail section that 

returns the words "SUM TAX PAID" if true, and the summer balance due if false. Time-

permitting, more complicated examples may be addressed as part of class discussion. 

  

1. If you haven't already, click the Show Toolbox, Field List, and Property Grid button. 

2. Click the Toolbox tab, then click/drag Calculated Field to the right of the 

WinTaxesBilled data field in the Detail section. When you release your mouse button, 

the Calculated Expression Editor appears just like in the previous lesson. Type 

SumBillPaid in the Expression name field. Use If-Statement is selected by default. 
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3. Click the Quick If-Statement Wizard button. The first part of the wizard appears. 
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4. Click the Data Column radio button, expand the ParcelMaster category, then the 

ParcelReadOnly category. 
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5. Locate totalbill_left_display. 
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6. Click Ok to return to the Quick If-Statement Wizard. Operator defaults to Equal To. 

Right Hand Side defaults to Constant Value/Number/0.000000. 
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7. Click Next. We are now on the "if true" part of the wizard. Constant Value is the 

default selection. Change Type to String, and type SUM TAX PAID in the Value field. 

 

In effect, we just told the program that if it is true that the bill has been paid in full, 

we want the report to display "SUM TAX PAID." Now we need to tell the program 

what to display if that is NOT true, i.e., the bill has not been paid at all, or has only 

been partially paid. 
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8. Click Next. We are now on the "if false" part of the wizard. Click the Data Column 

radio button, locate totalbill_left_display, and click Ok to return to the Quick If-

Statement Wizard. 
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9. Click Finish. You return to the Calculated Expression Editor, and your If-Statement 

appears in full. 
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10. Click Ok to return to the Report Designer. The calculated field is saved. 

 

11. Save and exit the report. Run the report to see the results.  
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Advanced Queries 
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Filters and Conditions; And/Or 

Advanced queries give you the flexibility of setting up simple queries, such as "find records 

where value equals X," and setting up more complex queries involving multiple filters and 

conditions on those filters. Filters and conditions depend on AND and OR statements, 

which are defined by determining "All" (AND) or "Any" (OR). 
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Filters: Report Data Must Match 

 

ALL: The report engine will return only those records that match every filter set up in the 

Filters pane, using that filter's conditions. 

For example, you have two filters: one looking for A and one looking for B. Of 200 

records, 50 records meet only the criteria for filter A, 30 records meet only the criteria 

for filter B, 20 records meet the criteria for both, and 100 records meet neither. As a 

result, 20 records will be returned. 

  

ANY: The report engine will return records matching either filter. 

For example, you have two filters: one looking for A and one looking for B. Of 200 

records, 50 records meet the criteria for filter A, 30 records meet the criteria for filter 

B, 20 records meet both, 100 records meet neither. As a result, 100 records (the 

50/30/20 records) will be returned. 
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Conditions: Filter Must Match 

 

ALL: Only those records that match every condition set for the currently-highlighted Filter 

Line will be included. 

For example, you have two conditions: one looking for records that "equals" C and one 

looking for records that are "less than" D. Of 100 records, 20 records meet only the 

"equals" condition; 10 records meet only the "less than" condition; 5 records meet 

both; 65 records meet neither. As a result, 5 records may be included (we say "may," 

because the number of records included will also be affected by your filter selection). 

  

ANY: Records matching either condition set for the currently-highlighted Filter Line will be 

included. 

For example, you have two conditions: one looking for records that "equals" C and one 

looking for records that are "less than" D. Of 100 records, 20 records meet only the 

"equals" condition; 10 records meet only the "less than" condition; 5 records meet 

both; 65 records meet neither. As a result, 35 records may be included (we say "may," 

because the number of records included will also be affected by your filter selection). 
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Set Up an Advanced Query 

This lesson will guide you through setting up a simple query to find parcels that have paid 

their winter taxes, but not their summer taxes. Time-permitting, complex queries may be 

addressed as part of class discussion. 

  

1. From the Run Reports dialog, select Parcel Reports as the Category, and Simple List 

as the Name. 
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2. Check the Apply Advanced Query to Population box. The Advanced Query button 

becomes enabled. 
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3. Click the Advanced Query button. The Advanced Query dialog appears. 

 

4. Report Data Must Match defaults to ALL Filters. We will keep this default. Click the 

Add button in the Filters pane. Select ParcelReadOnly as the Table; select 

WinTotalBillWIntrstBalance(totalbill_left_1) as the Field, and leave the Operator set to 

Equals. Leave the Value set to 0.00. 
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5. Click Ok. We now have our first condition for this filter. 

 

6. Click the Add button in the Conditions pane. Select ParcelReadOnly as the Table and 

select SumTotalBillWIntrstBalance(totalbill_left_0) as the Field. 
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7. Change the Operator to Greater Than, and leave the Value set to 0.00. 

 

8. Click Ok. We have the second (and final) condition for this filter. 
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9. Assuming this is a query we will want to run from time to time, our best option is to 

save it. Click the Save Query to DB button at the top. 
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10. New Query Name is the default selection. Enter the Query Name and click Ok. 

 

11. Click Ok to clear the confirmation prompt that appears. 

12. Click Close to return to the Run Reports dialog and run the report to see the results.  
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